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1 Introduction 
 

Radix SmartRecovery is a quick system recovery tool that allows computer users to restore 

disabled computers to their original state - and easily and quickly eliminate glitches and 

unwanted changes to the operating system and computer settings (logical faults), provided 

SmartRecovery was installed on the computer before any malfunction had yet occurred. 

The system is an effective work tool even for professional technical support managers. It can 

allow them to prevent any interruptions in business activity due to a massive failure on many 

computers simultaneously. SmartRecovery will also help you maintain computers operating 

outside the corporate security umbrella! 

Note! Installing the software requires appropriate knowledge and experience in computer 

hardware and software. If you do not have the proper knowledge or experience, do not install 

the software yourself. In case of a problem or uncertainty about how to proceed, stop the 

installation and contact the Radix support center. 

For more information, feel free to contact Radix’s technical support team. 

http://www.radix-int.com/
https://www.radix-int.com/contact/
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2 Getting Familiar with Radix 

SmartRecovery LITE V11 
 

2.1 System Requirements 

Before installing the Radix SmartRecovery software, the following actions must be 

performed. Not performing the operations as explained in this document may cause system 

malfunctions and damage the normal operation of the operating system and Smart Recovery. 

System Backup 

• Perform a backup of the operating system and your important data. 

Free space 

• Make sure there is at least 12% free disk space on the partitions you want to protect. 

• Make sure there is no HDD compression or encryption. 

• Run the Windows Defragmentation tool or an external defragmentation tool. 

• Run the Windows Checkdisk program or an external disk-checking tool. 

 

2.2 Important Points Before Installation of 

SmartRecovery 

Here is an important checklist to ensure that SmartRecovery can be installed properly on your 

computer. Before performing any of the following operations from Step 1 to Step 13, the 

Smart Recovery software must be removed if it was already installed. Performing any of the 

above actions when Smart Recovery software is installed may cause malfunctions and 

problems with the normal operation of the operating system and Smart Recovery. 

1. The Smart Recovery software is not a substitute for antivirus software. 

2. Make sure that the hard disk is not compressed using the Windows disk compression 

tool, or other similar compression tools. 

3. Make sure that Secure boot is canceled in the computer’s BIOS. 

4. Do not use any hard disk encryption software/tools when Smart Recovery software is 

installed. If you have any of these encryption tools installed (such as Windows 

BitLocker), they must be removed or disabled. 

5. Do not scan or defragment a hard disk after installing Smart Recovery software. 

6. It will not be possible to perform Windows Update, updating of Windows antivirus 

software, or to install applications from the Microsoft store when Smart Recovery is 

set for automatic system recovery mode. (These services are canceled automatically 

during the installation of Smart Recovery.)  

http://www.radix-int.com/
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Note: All of the above actions can only be performed after activating the built-in tool of the 

Smart Recovery software, WinUpdateSrv, which can be found in the installation folder of the 

Smart Recovery software. 

7. Do not use System Restore or create Microsoft restore points when the Smart 

Recovery software is installed (the service is canceled automatically during the 

installation of Smart Recovery). 

8. Do not change the structure of the disk partitions when the Smart Recovery software 

is installed. 

9. In the event that the disks have been duplicated by Acronis, before installing Smart 

Recovery, make sure that the MSR partition is not located on the first partition in the 

list. In this situation, it will not be possible to install Smart Recovery.  

If the operating system has been installed properly, the MSR (=Microsoft Reserved 

Partition) partition will appear in the following location (correct): 

 

If the disks have been duplicated by Acronis, the MSR partition will appear in the 

following location (incorrect): 

 

In this situation, it will not be possible to install Smart Recovery. 

In this case, it is possible to use the Partition Guru program. This program allows the 

deletion of a partition, without damaging the operating system. 

 

• Click here to download the PartitionGuru software for installation. 

• Click here for instructions on how to use the Partition Guru software. 

 

10. Do not reproduce or create an image of the hard disk after the Smart Recovery 

software has been installed. 

11. In the event that the computers have RAID, you must disable RAID (Smart Recovery 

does not support RAID). 

12. Uninstalling the product must be performed in an orderly manner. The SmartRecovery 

tool can be uninstalled either in DOS or in Windows. 

13. You should perform a scan and defragmentation of the hard disk before installing 

Smart Recovery. 

14. Run the following commands before installing Smart Recovery, through the 

PowerShell or the CMD line. Make sure that you run the commands with  

Administrator privileges. 

 

Command Function Desired Output Solution 

http://www.radix-int.com/
https://www.partitionguru.com/download.php/PGFreeSetup.exe
https://www.partitionguru.com/manual/manual.php
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manage-bde -status 
 

This command 
checks the status 
of BitLocker. 
BitLocker should 
always be turned 
off when running 
SmartRecovery. 

If the result is 
“Fully Decrypted” 
on all of the 
existing partitions, 
then BitLocker is 
not active. 

Canceling 
BitLocker is done 
by running the 
command “con”. 
At the end of the 
command line, 
add the letter of 
the appropriate 
disk partition. The 
process of 
canceling the disk 
encryption should 
take several 
minutes. 

 

 

Figure 2-1: Result when running the manage-bde -status command 

 

Command Function Desired Output Solution 

Confirm-
SecureBootUEFI 
 

This command 
checks the status 
of SecureBoot. 
SecureBoot must 
always be 
disabled when 
running 
SmartRecovery 

If the result is 
“True”, 
SecureBoot is 
active. 
If the result is 
“False”, 
SecureBoot is 
disabled. 

SecureBoot can 
be disabled from 
the BIOS settings, 
when booting the 
computer 

 

For SSD-type disks, a built-in mechanism called TRIM identifies which blocks of data on the 

disk are no longer in use and can therefore be erased. This mechanism conflicts with the 

SmartRecovery software. Therefore, it is necessary to disable it before installing 

http://www.radix-int.com/
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SmartRecovery. This is the query command to see whether the TRIM mechanism is active, 

and the solution: 

Command Function Desired Output Solution 

fsutil behavior 
query 
disabledeletenotify 
 

This command 
checks the status 
of TRIM. TRIM 
must always be 
disabled when 
running 
SmartRecovery. 

• If the result is 
“0”, TRIM is 
active. 

• If the result is 
“1”, TRIM is 
disabled. 

Disabling TRIM can 
be performed by the 
command fsutil 
behavior set 
disabledeletenotify 
1 

 

 

Figure 2-2: Response to query whether TRIM is disabled 

 

Figure 2-3: Disabling TRIM by the fsutil command 

You can download and run these batch files to perform the above checks: 

• dl.radix-int.com 

• https://dl.radix-int.com/smartrecovery/tools/SR_Prefs_Checker.zip.  

After downloading the zip file, extract the files and run the SR_prefs_check.bat file. 

http://www.radix-int.com/
https://dl.radix-int.com/smartrecovery/tools/SR_Prefs_Checker.zip
https://dl.radix-int.com/smartrecovery/tools/SR_Prefs_Checker.zip
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3 Installing Radix SmartRecovery LITE 
To start the software installation, download and run the SmartRecovery LITE installation file 

(RadixSmartRecovery_LTE_11.2.020_English_20240522_setup) and follow the instructions 

that appear on the screen that will guide you through the installation process. 

You can choose between three types of installation: 

 

• Default Installation: By default, this installation protects the partition where the 

operating system is installed (typically, Drive C:). The SmartRecovery login password 

is left blank. Here are the parameters for a Default installation: 

• Custom Installation: This allows you to define the protected partitions, set the 

password to log in to the system, and the configuration of the system restore (that is, 

Automatic or Manual).  

• Silent Installation: This allows you to load a pre-prepared automatic installation file, 

that contains all of the installation files, or by means of a batch file that contains the 

installation settings.  

3.1 Default Installation 

The simplest way to install SmartRecovery LITE is by relying on the default settings. In our 

example below, we performed a default installation. As a final sanity check before installing, 

we are informed that Drive C: (where Windows is installed) is protected, the Admin password 

is blank, and the computer performs a System Restore on every restart. 

http://www.radix-int.com/
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Figure 3-1: The user is shown the default settings before installation 

3.2 Custom Installation 

In Custom Installation, you will be able to select partitions to be protected, apply an 

administrator password, and select whether you want to perform an automatic or manual 

system restore.  

You will also be prompted about the location where you want to install the software. The 

default location is C:\Program Files\Radix\SmartRecovery LTE in a 32-bit operating system, 

and at C:\Program Files (x86)\Radix\SmartRecovery LTE in a 64-bit operating system.  

Later, you will be asked to choose which partitions you want to protect (Partition C: is 

defined automatically, and this setting cannot be changed). 

 

 

After choosing the desired method of installation, you will be requested to determine the 

following system settings: 

• Protected partitions: This sets the partitions you would like to protect. In the 

example below, Drive C: has been selected as the protected partition: 

http://www.radix-int.com/
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• Administrator password for the program: You can set a System Administrator 

password of up to 8 characters. 

 

• Manner of System Restore: You can choose between: 

http://www.radix-int.com/
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o Automatic restore: This will perform a system restore on every boot 

o Manual restore: This allows you to proactively perform a system restore 

 

• Choosing the Smart Recovery interface language: 

 

 

Note: All the settings can be changed later, including specifying partitions to be secured. 

 

3.3 Silent Installation 

This uses a configuration file to set up SmartRecovery using predefined settings. When you 

select Silent Installation, you will be prompted to browse for the configuration file on your 

computer. 

3.4 Automatic Installation from the Command Line 

A faster way to install SmartRecovery automatically is by using a batch file that Radix 

provides for this purpose. The batch file contains: 

http://www.radix-int.com/
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• The installation settings,  

• Details of which partitions are protected,  

• The configuration of the System Restore,  

• The Administrator password, and  

• Registration details for automatic registration of the SmartRecovery app. 

The batch file appears as follows:  

 
 

 

Use this link to download the automatic installation batch file.  

Here is an explanation of the contents of the batch file: 

Batch command Result 
ProtectPartition= “C:” 

 
Selects the protected partition 
(supports all versions).  
 
The options are the drive letters 
c:|d:|e:|... 

RecoveryMode = Auto 

 
Selects the recovery configuration 
automatic recovery/auto-
save/manual recovery (depending 
on the version of the product) 
 
The options are Auto/Save/No 

NewPassword = “12345678” 

 
Setting the protection password, 
where the password can be from 
0-8 characters 
(There is no default password) 

SupportMouseInDOS=yes Mouse support for the DOS 
interface of SmartRecovery.  
 
The options are yes/no (supports 
all SmartRecovery versions) 

http://www.radix-int.com/
https://dl.radix-int.com/smartrecovery/tools/batch_file/LITE11.1.BAT
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Lang=hebrew Selects the interface language of 
the SmartRecovery program in 
Windows 

Serial=“XXXXXXXXXXXXXXXXXXXXXXXXX” Registration code details for 
activation purposes 

 

3.5 Completing the Installation 

At the end of the installation (when doing a manual installation), you will be requested to 

reboot the system to complete the installation process.  

When doing an automatic installation, the operating systems will automatically reboot 

immediately at the end of the installation.  

Note: You can change the SmartRecovery settings after the installation, including 

protecting/canceling protection on the additional partitions on the hard disk. 

During the reboot of the system after the installation, the DOS environment of Smart 

Recovery will be installed automatically. This environment allows you to manage the use of 

Smart Recovery before loading the operating system. 

 

3.6 Product Activation 

SmartRecovery will work with full functionality for a trial period of 30 days from the time 

that you installed it. During this time, you can register the product. 

If you purchased the product, or if you reinstalled it and you have a license, you must 

perform registration during the trial period to continue using the product after the 30-day trial 

period.  

During the trial period, you will receive the following a pop-up notification, displaying the 

number of days left in the trial period:  

 

Important: If you did not activate a SmartRecovery account and decided to remove the 

product and reinstall it on the computer from which it was removed, reinstalling the product 

will start counting the days remaining at the moment of removal. For example: if you 

removed the product two days before the end of the trial period, when you install the product 

again on the computer from which it was removed, you will have two days until the end of 

the trial period. 

3.6.1 Performing Activation 
The activation operation can be performed in the following way: 

http://www.radix-int.com/
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1. Right-click with your mouse on the icon of the SmartRecovery program in the tray at 

the bottom of your display.  

2. Select About. 

 

3. In the About window, click on Register. 

 

4. In the next window, enter the serial number of the license: 

 

The licensing information must be entered as it appears in the licensing document you 

received.  

5. To finish, click “Register”. 

If you entered the registration information correctly, you receive a notification that the 

registration process was successful: 

http://www.radix-int.com/
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6. In the About window, you can see: 

• The name of the owner of the license,  

• The number of licenses ordered, and  

• The date and time of the registration: 

 

Figure 3-2: About window, displaying the username, number of licenses (=4), and registration date and time 

In the event that the license number is incorrect/not valid/does not exist, you will receive an 

error message: 

 

 

http://www.radix-int.com/
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• The product is activated by means of a server via the Internet. Therefore, you must 

make sure that the computers have Internet access. 

• If there is a website filtering service in your network, the service must be 

suspended/canceled until the product activation is finished. 

• If the product has not been activated, at the end of the trial period, the following 

message will appear. 

 

3.7 Activation After the End of the Trial Period 

If you want to continue working with the product at the end of the trial period, you will have 

to register. 

At the end of the license period, product activation will be carried out in the following way: 

• Clicking on “Open window” in the program icon among the tray icons . The red X 

indicates that the registration has expired. 

• The rest of the activation process will be performed as explained above in Section 

3.63.6, Product Activation). 

http://www.radix-int.com/
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4 Running Smart Recovery LTE from the 

Start Menu 
After you have successfully installed Smart Recovery LITE, you will have two options for 

accessing the Smart Recovery functions: 

1. Via the Start menu, by clicking on the Smart Recovery icon 

2. Via the Smart Recovery Tray Icon Menu 

When you run the SmartRecovery LTE from the Start menu (or from the SmartRecovery LTE 

icon in the taskbar), you will first encounter the login window: 

 
By default, the password is blank. 

4.1 Recovering your password 

If you set a password different than the default, and then forget it, you may recover it from 

Radix tech support.  

To recover your password: 

1. Click “Forget password”. You will see the following notification: 

 
2. Clicking OK runs the Acmpwd.exe file, which helps you recover your password. The 

following screen appears: 

 

 

http://www.radix-int.com/
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Figure 4-1: Password recovery screen. Note that the password is (null), since the password is presently blank. 

 

3. If you have created a password, you will see an encrypted version of your password.  

 

 
Figure 4-2: Encrypted password created by the Acmpwd.exe program 

4. Send the encrypted password to Radix technical support, and they will recover your 

password for you. 

 

4.2 Home Tab 

After you enter your password in the Login SmartRecovery LTE window and click Login, 

http://www.radix-int.com/
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the Smart Recovery LTE opening screen appears as follows: 

 
In the SmartRecovery LITE app, the Home tab displays only a single recovery point: the 

Root point. Every time you save a snapshot of your computer’s system, it will create a new 

Root recovery point. The Home tab will display the date when you created the most recent 

Root point. 

 

To perform a system recovery to the Root point: 

 

1. Select Recover. You will be prompted with the following notification. 

 

 
2. Click OK and select the Root recovery point.  

3. Click Recover. You will receive the following notification, that the computer will 

reboot and restore itself to the Root recovery point. 

http://www.radix-int.com/


Running Smart Recovery LTE from the Start Menu 

  
All rights reserved by Radix Technologies Ltd. 

© Radix SmartRecovery LITE User Manual 

www.radix-int.com | Telephone: 03-9606350 
Page 21 

 
4. Click Yes to reboot the computer and recover the system to the Root recovery point. 

4.3 Three-dot menu 

You will notice a three-dot menu in the lower right corner of the SmartRecovery LTE 

interface. The three-dot menu is visible at all times in the SmartRecovery LTE interface. 

Clicking on it gives you the following options: 

 

 
 

• Change Password 

• Tools 

• Uninstall 

• About & License 

We will go through the options in turn. 

4.3.1 Change Password 
When you click on the Change Password option, the Modify the Password window opens. 

http://www.radix-int.com/
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This will allow you to change the Administrator password.  

To change the password: 

1. Supply the old password in the Old textbox. 

2. Type in the new password in the New textbox and confirm it in the Confirm textbox. 

3. Click OK. The new password will be saved in the system. 

 

4.3.2 Tools  
When you click on the Tools option, you will see the following two options: 

 
4.3.2.1 Collect logs 

This opens the Collect Logs for Fault Analysis option, as described in Section 5.5.4, Collect 

Logs for Fault Analysis. The result is saved in a log file with the file extension *.zi_. 

 

http://www.radix-int.com/
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Figure 4-3: SmartRecovery Log file with the extension *.zi_ 

  

4.3.2.2 Browse RP 

When you click on Browse RP, this opens the Rexplore interface which allows you to 

browse previous recovery points. (A Recovery Point Browser icon will appear in the taskbar 

at the bottom of the Windows display.) 

 
Figure 4-4: Recovery Point Browser window 

Here is a brief explanation of the icons in the toolbar: 

http://www.radix-int.com/
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Icon Description 

 

Back: To go back to the previous screen when going 
through the directory tree. 

 

Export the file or directory: This allows you to save 
a file or directory to a different location. 

 

Close hard disk: This closes the display of the hard 
disk, until you select it again from File>Select 
physical disk. 

 

Large icons: Selecting this displays the files on the 
hard disk in the form of large icons: 

 

 

Report: Selecting this displays the files on the hard 
disk in List format: 

 
 

4.3.2.2.1 File Menu 

When you click on File, the following drop-down menu appears: 

http://www.radix-int.com/
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4.3.2.2.1.1 Select physical disk:  

This allows you to select a physical hard drive and choose one of its recovery points. 

1. If you click Select physical disk, the following screen appears: 

 

http://www.radix-int.com/
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2. When you select the hard disk in the list and click OK, you will see the hard disk 

appear in the Recovery Point Browser window, as well as the partitions available on 

the disk. 

 
 

3. Clicking on the hard disk displays the contents of the hard disk. 

 

http://www.radix-int.com/
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4.3.2.2.1.2 Select disk image 

This will allow you to select a VMware file image, to use as a system restore point. 

4.3.2.2.1.3 Close 

This will close the hard disk that you previously selected when you wanted to see its recovery 

points and file structure. Clicking on the Close icon in the Recovery point browser menu 

will also collapse the display of the hard disk in the Recovery Point Browser.  

To close a hard disk: 

1. Click on Close in the File menu or click on the Close icon in the Recovery point 

browser menu. You will be prompted if you wish to close the disk: 

 
 

2. Click on OK to close the hard disk. The display of the directory structure of the 

hard disk will disappear. 

To open a hard disk again: 

http://www.radix-int.com/
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1. Go to File>Select physical disk… 

2. Select the desired hard drive you would like to inspect for recovery points and click 

on it. Its recovery points and directory structure will be displayed again. 

4.3.2.2.1.4 Recent Files 

This will display any files that have been created recently and may be deleted if you perform 

a system restore to a previous recovery point. 

4.3.2.2.1.5 Exit 

This closes the Recovery point browser program and returns you to the SmartRecovery 

LITE window. 

4.3.2.2.2 View 

The View window gives options in displaying the files and directories displayed in the 

Recovery point browser. 

• Toolbar 

You can select whether to use the Recovery point browser with or without the toolbar icons: 

 

Figure 4-5: Recovery Point Browser with Toolbar and Status Bar 
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Figure 4-6: Recovery point browser without the Toolbar displayed 

• Status bar: 

This allows you to display the file structure of the hard disk with or without the status bar at 

the bottom. The status bar displays the statistics of the file or folder that you selected.  

For example, in the screenshot below, we see that there are a total of 6 items displayed, 3 of 

them are files, 3 of them are folders, and 1 item is selected. 
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• Show NTFS Meta file: This allows you to see hidden NTFS metadata files on an 

NTFS hard disk. 

4.3.2.2.3 Help 

This will display the version of the Rexplore Recovery Point Browser program.  
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4.3.3 Right-click menu  

 
By performing a right-click on one of the items in the Recovery Point Browser, the 

following menu opens: 

4.3.3.1 Export:  

This option lets you copy a selected file or folder to a different location. When you click on 

Export, the following window opens: 

 

You select a folder where you want to copy a file and click Select Folder. Before actually 

exporting the file or folder, you will be prompted as to whether you are sure to export the file 

or folder, to ensure that the file export does not damage existing files in the destination folder. 
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4.3.3.2 View 

By selecting a file and clicking on View, you open the file using the Notepad application. In 

the example below, we opened the Java file Hi.java: 

 

4.3.3.3 Information 

This provides information about a file: The file name, attributes, creation time, the file size, 

and more. 
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4.3.3.4 Large Icon 

Click on this option if you wish to view the files in the form of large icons instead of a 

detailed list. 

 

4.3.3.5 Report 

Click on this option if you wish to view the files in the form of a detailed list. 

 

4.3.3.6 Sort by  

This opens up a series of options for sorting the files being displayed: 
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• File Name: Sorts the files in alphabetical order, either ascending or descending 

• Attributes: Sorts files by their attributes: H – hidden files, S-System files, R-Read 

only files, D-Directory 

 

• Last Modified Time: Sorts the files by when they were last modified 

• Creation Time: Sorts the files by when they were created (latest first, or latest last) 

• Size: Sorts files by size, ascending or descending order. 

4.3.4 Uninstall 
When you click Uninstall, the following screen opens: 
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Upon clicking Apply, you have the option of: 

• Saving the current state before uninstalling,  

• Selecting a restore point as the final state before uninstalling.  

Note: Since this is SmartRecovery LITE, there is only a single restore point to select from: 

the root point. 

4.3.5 About & License 
When you click on the About & License option, the About window is displayed. It shows 

information about your registration for the SmartRecovery LTE application. It shows: 

• The type of registration 

• How many accounts have been registered 

• The date when you registered the application 

• How much time is left in your trial account, if you have not yet registered the product 
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To register your version of SmartRecovery LITE: 

1. When you click Register, you will be prompted to either: 

a. Supply a product registration serial number in the Authorization detail 

prompt or  

b. Upload a file with the registration information, by clicking on the three-dot 

icon. The file will have the extension *.sni.  

 

 
  

 

Three-dot icon 

to upload a 

registration file 
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If you choose Export register file, you can save the file with the registration information to 

send it to Radix and register the product offline. The file will have the file extension *.mi. 

 
If you don’t have Internet access, you can choose to export the registration file to the site 
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https://snmgr.edusoft.vip/offline. 

 

 
 

4.4 Recovery Points Tab 

 
Here is a brief explanation of the options: 

• Type of view: You can view the Recovery points either in List View, or Tree View. 

(Note: Since SmartRecovery LITE only allows for one recovery point, you only see 

one point in the list.) 
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Figure 4-7: Displaying the recovery points in List View 

 

 
Figure 4-8: Displaying the recovery points in Tree View 

• Sort by: This allows you to select how to list the recovery points. The options 

include:  

o By time (ascending/descending) 

o By name (ascending/descending) 

o By size (ascending/descending) 

• Save a new RP (=Recovery Point): This allows you to save another recovery point. 

SmartRecovery LITE only allows one recovery point at a time, so this button is 

inactive, as indicated by the lock on the icon .  In SmartRecovery DUO and PRO 

which allow you to save more than one recovery point, this button is active. 

• Details: This displays details about the recovery point, such as its name, the date it 

was saved, and the size of the amount of the hard disk used at the time of that 

recovery point. The only live option is Display RP, which allows you to select if the 

Recovery Point is displayed or not. 

• Recover to: When you click on this button, this allows you to perform a system 

recovery to the Root point. 
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You will be prompted as to whether you are sure to restore the system to the Root point. 
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4.5 Settings Tab 

4.5.1 Startup Mode Option 

 
 

This can allow you to choose the startup default recovery settings: either Recover, to perform 

a system recovery automatically (Recover upon startup), or No action (Manual recover). 

• When you click “No action”, system recovery will be done manually, not upon 

startup. 

• When you click “Recover”, the system recovery will be done automatically upon 

startup. You can either choose Undo, to switch it back to manual restore, or Apply, to 

go ahead with Automatic Recovery upon booting up. 

 

4.5.2 Startup Process Option 
When you click on the Startup Process option, the following screen appears: 
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It provides you with the following options:  

• Display countdown bar: This will display a countdown bar for the specified number 

of seconds when you boot your computer, before it enters Windows. During this 

countdown period, you can click Home on your keyboard for more DOS recovery 

options. 

• Show recovery point list: This displays the recovery point options in DOS. Since we 

are discussing Smart Recovery LITE, there is only the root recovery point. 

• Select customized image: You may upload an image here, which will serve as the 

background to the Smart Recovery LITE recovery screen when in DOS. 
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• Default: This allows you to use the default background image when in DOS mode. 

• Custom: This allows you to select a customized background image when using Smart 

Recovery in DOS mode. 

o If you click Undo, this will undo all of the changes that you have made to the 

startup process configuration and revert back to the default settings. 

o If you click Apply, you will apply all of the changes that you have made to the 

Smart Recovery application. 

If you make any changes in this screen, and then try to open another tab in the sidebar menu, 

you will get a reminder to apply your changes: 
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4.5.3 DOS Hotkeys Option 
As we will see in Section 6, Operating SmartRecovery LTE from DOS, SmartRecovery 

can be run in DOS mode. This can be a lifesaver if your Windows installation has become 

corrupted, and you want to restore the system to a baseline point before the crash. However, 

when in DOS mode, you may not have use of your mouse. (There is an option to add mouse 

functionality in the DOS window.) SmartRecovery has a feature to assign keystroke 

combinations to access the SmartRecovery commands when using SmartRecovery in DOS 

mode. 

When you click on DOS Hotkeys, the following window opens: 
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As you click through the Function list of SmartRecovery options, you will notice that some of 

them are already assigned a hotkey keystroke combination. You can assign a keystroke 

combination to particular commands, as well as modify the hotkey settings for commands. 

To assign a hotkey combination to a DOS command: 

1. Select the DOS function from the Function list. 

2. In the Enter new hotkey textbox, type a key combination. It can be a combination of 

one of the Function keys F1-F12, or Ctrl or Shift, as well as an alphanumeric 

character (A-Z/0-9). In the example below, we would like to assign the F6 key to 

show the recovery point list when the computer boots up. 
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3. If you would like to protect the hotkey combination with a password, click on the 

checkbox Check password. In the example below, the F6 key to show the recovery 

point list is now password protected. 
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4. Click Add to add the hotkey combination to the DOS function. 

5. If you try to assign a previously assigned hotkey to another function, you will get the 

following notification: 
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Click Yes to assign the hotkey to another function. 

6. Click on Apply for the changes to go into effect, or Undo to cancel the changes. 

 

To delete a hotkey combination from the list: 

1. Select the hotkey combination from the Hotkey list box.  

2. Click on the Delete button. The hotkey option will be removed. 

4.5.4 Installation Mode Option 
When working in this mode, there is no disk protection at all. Any changes will be fixed in 

the operating system immediately. Take care when performing actions in this setting.  
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When exiting this mode, there is no need to update to a baseline point.  

1. If you want updates of the operating system to be performed automatically under this 

mode, check the check box “Auto-detect Windows feature update” and at the end 

click “Apply”. 

Note: To click the Auto-detect Windows Features Update box, you must be in manual 

mode. If you have set Smart Recovery to perform automatic system recovery, you will 

receive the following alert: 
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To go to Manual Restore mode, click on the Startup Mode tab in the sidebar menu, and 

click ‘No action”. 

 

2. In order to switch to this mode, click Enter install mode now. 
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Upon clicking on Enter install mode, a notification will appear that elucidates which further 

actions to take. 

 

The message clarifies that by switching to this mode, the operating system will be completely 

open, and all restore points will be erased. You will not be able to perform a system recovery 

when Smart Recovery is in installation mode. 

3. To perform the operation, click Yes. To cancel, press No. 
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5 Tray Icon Menu 
When you perform a right-click on the SmartRecovery icon in the desktop tray, the following 

menu opens: 

 

We will go through these options in detail. 

5.1 Open Console 

When you click on the Open Console option in the tray icon menu, the SmartRecovery 

console opens: 

 

5.1.1 Home Tab 
When you click on the Home tab, you will see two Restore Mode options: 

• Restore at every boot (Automatic Restore): To perform a system recovery 

automatically upon every bootup of the computer. The restore will be to the time of 

the last update. 
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• Manual Restore: To perform a system recovery manually. When you click Restore 

System, it will restore the computer to the last system update, as displayed (in the 

example below, it will restore to March 01, 2025, at 23:58:22). 

 

Select Restore at every boot (Automatic Restore) or Manual Restore. Click Apply to save 

the setting. 

 

• Restore System: Clicking this will restore the system to the last system update point. 
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• Save Changes: By clicking this button, the computer will reboot immediately and 

then take a new snapshot of the system. It will thus save changes to the system and 

thus create a new baseline point, without performing a system restore to the root 

point. 

 

We will examine these options in turn.  

5.1.1.1 Restore Mode Options 

• Restore at every boot (Automatic restore): In this setting, the system automatically 

performs a system recovery each time it is turned on or rebooted.  Automatic recovery 

will restore the operating system and all protected partitions to the last normal state 

that the system administrator defined.  

Note: When in Automatic restore mode, the Smart Recovery icon will turn green. 
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• Manual restore: In this setting, the system undergoes a system restore on demand. 

Disabling Automatic Recovery mode is intended for cases where you want to install 

software and perform other changes to the system, without the need to perform a save 

before every start-up.  

Note: When in Manual restore mode, the Smart Recovery icon will turn gray. 

 

• Restore System Option: This restores the computer to the state it was in the last time 

you saved changes and created a new basepoint.  

When you hover your mouse on the Restore System button, the Smart Recovery 

Console will give you the following message, informing you that the computer will be 

restored to the last system update that was saved: 
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1. Click on Restore System. You will receive a notification that the system will 

restore to the latest saved system snapshot: 

 

2. Click Yes to continue. The system reboots and is restored to the most recent 

snapshot. 

• Save Changes: 

When you hover your mouse over the Save Changes button, the Smart Recovery console 

gives you the following message, informing you that the system’s present configuration will 

be saved as the new basepoint: 

 

1. Click on Save Changes. You will receive the following notification, whether 

you wish to save the system as the new baseline snapshot: 
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2. Click Yes to continue. The system reboots and the computer’s most recent 

state is saved as the new snapshot. 

5.1.2 Settings Tab 
To get to the software settings screen, click the “Settings” tab: 

 

5.1.2.1 Set Password 

To set a password, or change an existing password: 

1. Enter your present password under Current Password.  

2. Enter the new password in the New password textbox and confirm it in the 

Confirmation password textbox. You can select a password of up to 8 characters. 

3. At the end of the process, click Apply.  

Note: When you install Smart Recovery, the default setting is that the password is blank. 
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4. If you forget your password, you can recover it by the procedure described below in 

Section Error! Reference source not found., Error! Reference source not found.. 

5.1.2.2 Uninstall 

The Smart Recovery console will allow you to uninstall Smart Recovery. 

To uninstall SmartRecovery: 

1. Go to “Settings” and click on the “Uninstall” button. 

2. In the next window, you will be prompted for the Administrator password. Supply the 

password. 

3. The system will ask you to select the removal configuration. There are two options: 

• Keep the current state and then uninstall: This creates a snapshot from the system’s 

current state and then uninstalls SmartRecovery. 

• Restore to the baseline and then uninstall: This restores the computer to the 

previous save and then uninstalls SmartRecovery. 

 

5.1.2.3 About 

When you click About, the About screen appears. It will display: 

• The name of the owner of the license,  

• The number of licenses ordered, and  

• The date and time of the registration: 
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Figure 5-1:About window for registered user 

If you are currently using a trial version of SmartRecovery, the About window will display 

how many days remain in your 30-day trial period: 

 

Figure 5-2: About window for the trial version of the SmartRecovery app 
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5.2 Switch to “Manual Restore”/Switch to “Auto 

Restore” 

This menu option allows you to toggle between “Manual Restore” mode and “Auto Restore” 

mode. As mentioned in Section 5.1.1.1, Restore Mode Options, in Auto Restore mode, the 

computer will go back to the previously saved root point every time you reboot the computer. 

In Manual Restore mode, changes to the system will remain until you choose to do a system 

restore to the most recently saved root point. 

To go to Auto Restore from the tray icon menu: 

1. Click on Switch to “Auto Restore”. You will receive a prompt notification to verify: 

 

2. Upon clicking Yes, you will get a popup notification that you are now in Automatic 

Restore mode: 

 

3. If you wish to go back to Manual Restore, go back to the tray icon menu, and select 

Switch to “Manual Restore”. You will receive the following prompt: 

 

4. Upon clicking “Yes”, you will receive a popup notification that you have gone to 

manual restore mode. 
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5.3 Restore System 

If you click on Restore System, the computer will go back to the last snapshot that you took 

of the system. It will not include the changes and additions added over time if you did not 

save those changes at some point.  

When you choose to restore the system (using the “Restore System” button), the following 

message box will appear:  

 

• Choosing “Yes” will reboot the operating system and perform a system restore. 

• Choosing “No” will cancel the operation and return to the Administrator interface. 

5.4 Save Changes 

Saving the changes made (by clicking on the “Save Changes” button in the System Tray 

icon) will save the changes that were added to the system. When you choose to perform a 

system update by saving changes, a message will appear with a yes/no question: 

• Choosing “Yes” will reboot the operating system and save the computer’s present 

state as a new snapshot. 

• Choosing “No” will cancel the operation and return to the Administrator interface. 

 

 

5.5 Tools Menu 

When you click on the Tools option in the tray menu, the following menu opens up: 
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5.5.1 Enter Installation Mode 
When you enter installation mode, the hard disk where the operating system is installed is 

without protection. “Installation mode” is also known as “Open Mode”, because it opens the 

operating system, erases recovery points, and allows changes to the disk partitions. On the 

other hand, a protected partition is one where no changes can be made to the partition’s 

structure. 

Changing the restore configuration to Install Mode can be performed by clicking on Enter 

Installation Mode in the program icon in the system tray, next to the system clock. 

To switch to “Installation Mode/Open Mode”: 

1. Right-click on the Smart Recovery icon in the system tray , and under Tools, select 

Enter Installation Mode. 

Note: Once you are in Installation Mode, the SmartRecovery icon will not open the 

application. 

 

2. You will be requested to enter your password, and then you will receive the following 

message: 

 

• Choosing “Yes” will boot the system and enter Installation Mode.  

• Choosing “No” will cancel the action. 

3. To exit Install Mode, choose Exit Install Mode from the system tray icon. 
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4. Enter your password and click OK. 

5. In the following dialog box, click OK. 

 

At this point, the operating system will reboot and return to normal working mode. 

5.5.2 Protecting Additional Disk Partitions  
If you want to protect additional partitions existing on the disk when Smart Recovery has 

already been installed, for example, C: or D:, you can do this after switching to “install 

mode/open mode”.  

In the following example, there is one partition (Local disk (D)) that is not protected. The 

partitions marked with a question mark (?) are protected and cannot be changed. 

 

1. Mark the partition you want to add to the protection. In the upper part of this window, 

you can see which partitions are protected. With the addition of the new partition, you 

can see that it has been added to the installation. 
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2. To complete the action, click OK in the following dialog box. 

 

At this point, the operating system will reboot to accommodate the new changes. 

5.5.3 Removing Protection from a Partition 
You can use Installation Mode to remove protection from a partition. 

To remove protection from a partition: 

1. Go to the tray icon and click Tools>Enter Installation Mode. 

 

Switching to installation mode automatically removes the protection from partitions to 

which protection was added in open mode. 

2. Click on Re-select protected partitions in the following dialog box and select the 

partitions that you would like to modify now. 
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5.5.4 Collect Logs for Fault Analysis 
In the event of a malfunction that cannot be solved immediately, SmartRecovery includes the 

Pmonitor tool. It creates a log file which will allow us to identify the cause of the malfunction 

and provide a solution. 

To create a log file: 

1. Click the right mouse button on the Smart Recovery Tray icon. 

2. Click on the “Tools” option and select the “Collect Logs” button. 
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This will run the Pmonitor tool.  

3. Alternatively, you can find the Pmonitor file in the folder C:\Program Files 

(x86)\Radix\SmartRecovery LTE. Clicking on the file will also run the Pmonitor 

program. 

4. When the program starts running, you will see a green status bar: 

 

5. Click on the green area to start the log collection operation. The green status bar will 

display messages about the information being collected. 

 

 

 

6. When Pmonitor finishes creating a log file, you will receive the following dialog box: 
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It provides the following options: 

• In the “Your contact information” textbox, you can provide an email address where 

you wish to receive correspondence from Radix regarding the log file. 

• Save As: This allows you to save the log file on your computer, after you assign it a 

name and location. The Pmonitor tool will compress the file into zip format.  

Note: To allow the file to be sent by email without any security problems, it will be 

saved with the file extension *.zi_.  

 

Assign a name to the file, but do not change the file extension. 

• Re-obtain: This will allow you to re-run the Pmonitor tool, to compile a new log file. 

• Send: This will send the file to Radix. Alternatively, you can send the file as an 

attachment via email to radix@support.co.il. 

• Don’t send: Select this option if you would prefer to send the log file by email, 

instead of the Pmonitor interface. 

7. Send the file to us. We will check the logs and contact you. 

5.5.5 Enable Windows Update/Disable Windows Update 
Updates to the operating system and its apps are required from time to time. For example, 

you’ll need to update the operating system when replacing hardware, installing new software, 

updating existing software, installing Windows updates or antivirus updates, or changing any 

settings in the software installed under the protected drive.  

The process of updating the operating system using SmartRecovery is very simple. However, 

you must be in Manual Restore mode to enable Windows updates.  

Updating the operating system can be done in one of the following two options: 

5.5.5.1 Method One—From the Home Tab 

In the Smart Restore interface, under the “Home” tab, in “Restore Mode:” change the restore 

mode to “Manual Restore” and confirm the operation by clicking on “Apply”. 
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5.5.5.2 Second Method—From the Tray Icon 

You will have to be in Manual Restore mode to enable Windows Updates.  

1. Open the Smart Recovery menu from the Tray icon and click Switch to “Manual 

Restore”. 

 

2. In the next message box, click Yes. 

 

3. After you have entered Manual Restore mode, right-click on the Smart Recovery icon. 

4. Click on “Tools” and select “Enable Windows Update”. 
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4. In the next notification box, click OK: 

 

5. If you tried to allow Windows updates before changing the restore configuration to 

Manual Restore, the following message will appear: 

 

In this case, change the restore configuration to Manual Restore, and click Retry on this 

message box. 

• The required update will be performed. Updating Windows can include rebooting the 

system if the update requires it. 

• Check that the update is to your satisfaction and does not interfere with the computer's 

operation. This step is critical in the correct use of SmartRecovery. (See the note 

below.) 

6. When finished, save the changes that have been made in SmartRecovery by clicking 

on the update button, “Save Changes”. 

 

The Save Changes operation can be performed from the software’s Administrator interface, 

or from the Tray Icon menu. 

After doing this, the operating system will reboot.  You can then switch the recovery 

configuration back from Manual Restore to Automatic Restore. 
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Note: In “Manual Restore” mode, the system still protects the operating system. If you are 

not satisfied with the update or the changes you made, you can perform a restore to the 

previously saved point by clicking the “Restore System” button. 

Important: 

• The installation of Smart Recovery completely disables the possibility of performing 

Windows Updates. As a result, it disables the possibility of performing Windows 

antivirus updates. In the Windows 10 operating system, it cancels the possibility of 

installing applications from the Microsoft app store. 

• While performing updates, the operating system may reboot. The installation of the 

updates must be enabled in full. 

5.5.6 Finishing Installing Windows updates 
At the end of the process of installing Windows updates (if any) and only when a message 

appears that the operating system is updated, click on the Smart Recovery icon in the Tray 

Icon, and select “Disable Windows Updates” to cancel the Windows update mechanism. 

 

At the end of the operation, the following message will appear. 

  

Important: If you do not choose “Disable Windows Updates”, the operating system will 

perform updates automatically, which may cause malfunctions in the regular workings of the 

operating system and Smart Recovery. 

Note: To enable Windows Update, you must be in Manual Restore Mode. After installing 

SmartRecovery, if you wish to enable the computer to install Windows Updates, you must 

first enter Manual Restore mode. If you click on Enable Windows Update, you will receive 

the following notification: 
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5.6 About 

Clicking About in the Tray Icon menu will display information about your SmartRecovery 

registration. If you have not yet registered the product, click Register to complete the 

process. 
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6 Operating SmartRecovery LTE from 

DOS 
The Smart Recovery system can also be operated before the operating system boots up, and 

without any dependence on the integrity of the operating system. This feature allows recovery 

of the operating system even in a situation where the operating system does not load, and/or 

is not working properly. 

To enter the SmartRecovery interface from DOS: 

1. Turn on the computer. Before the operating system boots up, press the “Home” key on 

your keyboard for several non-consecutive presses. 

2. Upon entering the interface, you will receive the following screen where you will be 

asked to enter the Smart Recovery Administrator password: 

 

3. After entering your password, the main screen of Smart Recovery will appear: 

 

You can select the SmartRecovery options using the arrow keys on your keyboard.  

Note: Your mouse pointer may not appear on the screen initially. In order to enable use of 

your mouse, go to Settings, and click on the Tab button on your keyboard until you reach 

Enable mouse. Click on the space bar to check the Enable mouse checkbox and activate 

your mouse.). 
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If you don’t press Home several times when your computer boots, the Smart Recovery LITE 

DOS screen appears. 

 

Click on your space bar to pause your computer and use the Smart Recovery DOS 

commands. 

• Press Esc to cancel Smart Recovery and proceed to boot into Windows. 

• Press Home or Scroll Lock to get back to the Smart Recovery DOS menu. 
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The following table summarizes the DOS interface options: 

Icon Description 

 

Reserve: Continue to boot into the operating system 
without performing any recovery operation 

 

Recover: Restore the operating system to the 
specified restore point 
 

 

Defragment: Defragmenting saved restore points 
 

 

Update primary point: Updating the system. This 
will replace your “root” recovery point with the current 
state of the system.  
 

 

Settings: Changing system settings such as: 
changing recovery configuration, setting the system 
password, and more... 

 

Uninstall: Uninstalling SmartRecovery 
 

6.1 Reserve 

When you click on Reserve, you will receive the following prompt: 
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Click OK to proceed to the Windows operating system. 

6.2 Recover 

When you click on Recover, you will receive the following prompt: 

 

Click OK to recover to the latest recovery point, and reboot to Windows. 

6.3 Defragment 

When you click on Defragment, you will receive the following prompt: 
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Click OK to defragment your hard disk. 

6.4 Update primary point 

When you click on Update primary point, you will receive the following prompt: 

 

Click OK to reboot the computer and save the current state of the computer as a new root 

point. 

6.5 Settings 

When you click on Settings, the following window opens: 
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The options are: 

• Auto Recover: To perform automatic recovery on every reboot. 

• No Action: To only perform manual recovery. 

• Change password: This allows you to create a new password for Smart Recovery. 

• Support Mouse: To allow for using your mouse in the Smart Recovery DOS window. 

6.6 Uninstall 

When you click on Uninstall, you will receive the following prompt: 

 

Click OK to uninstall Smart Recovery LITE. 

Note: During the uninstallation of Smart Recovery from the DOS interface, a window will be 

displayed that will allow you to select a point to which you will return. 
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• Choose 1 to restore the computer to the Root recovery point and uninstall Smart 

Recovery. 

• Choose 2 to keep the current system and uninstall Smart Recovery. 

• Choose Cancel to go back to the Smart Recovery DOS options. 

After the uninstall, the software will be removed, and the system will revert to the selected 

recovery point. 
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7 Help and Technical Support 
We would be glad to receive any comments or suggestions for improvements and corrections 

to the SmartRecovery app. If you have any further questions, you can contact us: 

• By phone: 03-9606350,  

• On WhatsApp: 055-3058039, 

• By email: radix@support.co.il, 

For information about additional Radix products, write to us at info@radix-int.com. 

If you have any problems or questions, click here to create a ticket with Radix technical 

support. The ticket appears as follows: 

 

Figure 7-1: Radix Tech Support Ticket 
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